NAE Commissioning for Simplex Fire System Integration
Contents

Introduction ...................................................................................................................................... 3
  System Integration Contacts ........................................................................................................ 3
Related Documentation ................................................................................................................... 4
Component Requirements .............................................................................................................. 4
Equipment Objects Created During Integration ........................................................................... 5
ES Panel Programmer ...................................................................................................................... 6
  SMC FieldServer Toolbox ........................................................................................................... 6
Mass Changes Tool (MCT)............................................................................................................... 6
  Configuring the Simplex Integration in MCT ........................................................................... 7
  Importing the Integration into an SCT database ....................................................................... 9
  Inserting the Integration into an SCT database from MCT ....................................................... 10
System Configuration Tool (SCT) ................................................................................................. 11
  Adding a BACnet IP Integration .............................................................................................. 11
  Defining Spaces in SCT .......................................................................................................... 11
  Assigning Equipment to Spaces .............................................................................................. 12
Metasys UI Offline ...................................................................................................................... 14
  Configuring the Graphical Representation of Spaces ............................................................... 14
  Adding Symbols to Floor Plans ............................................................................................. 15
  Binding FACU Point Information to Symbols ......................................................................... 16
  Creating a Graphical Representation of the FACU ................................................................. 17
  Configuring Symbols for the FACU Aliased Graphic ............................................................ 19
Downloading the Archive to Devices ......................................................................................... 21
Software Terms ............................................................................................................................. 21
### Introduction

This document describes how to use the Mass Changes Tool to integrate a Simplex® Fire Alarm Control Unit (FACU) into a Metasys® system. This document does not describe how to configure the FACU hardware or how to install a Metasys system. This document only includes information that is specific to the integration process. For additional information, see Related Documentation.

The following figure shows the process required to complete the integration.

**Figure 1: Overview of the integration process**

After you complete the integration process, a Simplex FACU communicates point information, including alarm status, to a Metasys supervisory engine. As part of the integration process, you configure which points the system monitors. The integration is a secondary monitor of the information. The Metasys supervisory engine does not control the fire system.

➤ **Important:** The integration described in this document does not meet, nor intends to meet, the requirements for the UL 864 UUKL/ORD-C100-13 UUKLC 10th Edition Smoke Control Listing. For more information, refer to the Metasys System UL 864 10th Edition UUKL/ORD-C100-13 UUKLC Smoke Control System Technical Bulletin (LIT-12012487).

### System Integration Contacts

For information about Johnson Controls® integration on NIEx9, SNMP®, LonWorks®, BACnet™, OPC™, N2 Open, and other protocols or applications, contact Johnson Controls Systems Integration Services at the following addresses.

**Table 1: SIS Offices Location**

<table>
<thead>
<tr>
<th>Milan</th>
<th>Essen</th>
<th>North America</th>
</tr>
</thead>
<tbody>
<tr>
<td>Johnson Controls - SIS Europe, Milan Operations</td>
<td>Johnson Controls - SIS Europe, Essen Operations</td>
<td>Johnson Controls - SIS NA</td>
</tr>
<tr>
<td>Via Manzoni, 44</td>
<td>Westendhof 8</td>
<td>9410 Bunsen Parkway, Suite 100A</td>
</tr>
<tr>
<td>20095 Cusano Milanino, MI, Italy</td>
<td>45143 Essen, Germany</td>
<td>Louisville, KY 40220</td>
</tr>
<tr>
<td>Phone +39 02 28042 1</td>
<td>Phone +49 201 2400 425</td>
<td>+1 502 495 6700</td>
</tr>
<tr>
<td>Fax +39 02 28042 221</td>
<td>Fax +49 201 2400 457</td>
<td></td>
</tr>
</tbody>
</table>
Related Documentation

<table>
<thead>
<tr>
<th>For Information about</th>
<th>See Document</th>
</tr>
</thead>
<tbody>
<tr>
<td>Daily operation of the Metasys system network, monitoring and controlling BAS networks</td>
<td>Metasys SMP Help (LIT-1201793)</td>
</tr>
<tr>
<td>Metasys system network features and functions</td>
<td>Metasys System Configuration Guide (LIT-12011832)</td>
</tr>
<tr>
<td>General Metasys network and Information Technology definitions and concepts</td>
<td>Network and IT Guidance Technical Bulletin (LIT-12011279)</td>
</tr>
<tr>
<td>Adding a BACpac™ card to an ES Panel Programmer, and exporting integration files</td>
<td>Use the ES Panel Programmer Application Help¹</td>
</tr>
<tr>
<td>Using the SMC FieldServer Toolbox to program the BACpac card</td>
<td>FieldServer Toolbox and Graphic User Interface (FS-GUI) Manual</td>
</tr>
<tr>
<td>Using the Mass Changes Tool to configure fire panel points</td>
<td>Use the Mass Changes Tool Application Help</td>
</tr>
<tr>
<td>Using SCT to configure equipment and spaces in an archive database</td>
<td>Metasys SCT Help (LIT-12011964)</td>
</tr>
</tbody>
</table>

¹ Alternatively, create an account at simplex-fire.com and search for ES Panel Programmer.

Component Requirements

To integrate Simplex FACU systems, you require the following hardware components:

• Simplex Fire Alarm Control Unit (FACU)
• RS-232 card for Simplex FACU
• BACpac card for Simplex FACU
• Network Engine
• Optional: Metasys server, such as an Application and Data Sever (ADS), Extended Application and Data Server (ADX), or ADS-Lite.

⚠️ **Note:** ADS/ADX and ADS-Lite Site Directors support spaces and equipment. Network Engine Site Directors do not support spaces and equipment configuration.

• Ethernet connection between BACpac card and the supervisory device

To integrate Simplex FACU systems, you require the following software components:

• ES Panel Programmer
• SMC FieldServer Toolbox
• Mass Changes Tool (MCT), at version 2.6 or above
• System Configuration Tool (SCT), Release 13.0 or above
Equipment Objects Created During Integration

The Mass Changes Tool creates Metasys UI Equipment objects. The MCT creates one equipment object that contains a set of points that represent the overall state of the Simplex Fire Alarm Control Unit. The MCT also creates additional equipment objects based on the set of points that you select in the Simplex ES panel programming tool when you create the CSV export file. The tool creates one equipment object for each Simplex panel point. For each equipment object, the tool creates one multistate point to indicate the status of the Simplex point.

Multistate values include the following:
- Normal
- Fire Alarm
- Priority 2
- Supervisory
- Trouble
- Utility
- Control
- Disable
- Primary State

Note: To assist you in the system commissioning and operation process, the MCT process adds trends and alarms to all of the MI mapped points. Each mapped MI object has either an alarm extension or a trend extension based on the point type defined in the Simplex panel. Simplex panel points that can create Fire Alarm, Priority 2, or Supervisory states have an alarm extension defined. All other points have a Change of Value (COV) trend for historical data mining.

The Panel Status Equipment Object contains the set of points shown in the following table.

Table 3: Points Included in the Panel Status Equipment Object

<table>
<thead>
<tr>
<th>Point Name</th>
<th>Point Label</th>
<th>BACNet Point Type</th>
<th>States</th>
</tr>
</thead>
<tbody>
<tr>
<td>P11</td>
<td>UNACKNOWLEDGED FIRE ALARM EXISTS</td>
<td>BI</td>
<td>Normal/FIRE</td>
</tr>
<tr>
<td>P12</td>
<td>UNACKNOWLEDGED SUPERVISORY EXISTS</td>
<td>BI</td>
<td>Normal/SUPERVISORY</td>
</tr>
<tr>
<td>P13</td>
<td>UNACKNOWLEDGED TROUBLE EXISTS</td>
<td>BI</td>
<td>Normal/TROUBLE</td>
</tr>
<tr>
<td>P201</td>
<td>AC VOLTAGE FAILURE/ BROWNOUT</td>
<td>BI</td>
<td>Normal/AC FAILURE</td>
</tr>
<tr>
<td>A0</td>
<td>NUMBER OF SYSTEM FIRE ALARMS</td>
<td>AI</td>
<td></td>
</tr>
<tr>
<td>A1</td>
<td>NUMBER OF SYSTEM SUPERVISORIES</td>
<td>AI</td>
<td></td>
</tr>
<tr>
<td>A2</td>
<td>NUMBER OF SYSTEM TROUBLES</td>
<td>AI</td>
<td></td>
</tr>
<tr>
<td>A115</td>
<td>EXCESSIVELY DIRTY (OUT OF RANGE)</td>
<td>AI</td>
<td></td>
</tr>
</tbody>
</table>
Table 3: Points Included in the Panel Status Equipment Object

<table>
<thead>
<tr>
<th>Point Name</th>
<th>Point Label</th>
<th>BACNet Point Type</th>
<th>States</th>
</tr>
</thead>
<tbody>
<tr>
<td>A116</td>
<td>DIRTY SENSOR COUNTER</td>
<td>AI</td>
<td></td>
</tr>
<tr>
<td>A117</td>
<td>ALMOST DIRTY COUNTER</td>
<td>AI</td>
<td></td>
</tr>
<tr>
<td>1-0-0</td>
<td>CARD MONITOR</td>
<td>BI</td>
<td>Normal/PS ERROR</td>
</tr>
<tr>
<td>1-0-9</td>
<td>POSITIVE EARTH</td>
<td>BI</td>
<td>Normal/POS GROUND</td>
</tr>
<tr>
<td>1-0-10</td>
<td>NEGATIVE EARTH</td>
<td>BI</td>
<td>Normal/NEG GROUND</td>
</tr>
<tr>
<td>1-0-11</td>
<td>AC FAILURE</td>
<td>BI</td>
<td>Normal/AC FAILURE</td>
</tr>
<tr>
<td>1-0-12</td>
<td>BATTERY LOW</td>
<td>BI</td>
<td>Normal/LOW BATTERY</td>
</tr>
<tr>
<td>1-0-13</td>
<td>DEPLETED/MISSING BATTERY</td>
<td>BI</td>
<td>Normal/DEPLETED-MISSING BATT</td>
</tr>
</tbody>
</table>

ES Panel Programmer

The ES Panel Programmer application provides a user interface for programming an ES Panel job. Use the ES Panel Programmer to complete the following tasks:
1. Configure the BACpac module.
2. Select the point information to include.
3. Specify the BACnet input format for each BACpac card.
4. Create zones, and assign points to them.
5. Export the BACpac configuration file and Metasys Integration Data file.

Use the Simplex ES Programmer BACpac Export Wizard to configure the BACpac card. For documentation on use of the ES Panel Programmer, see Table 2.

SMC FieldServer Toolbox

The SMC FieldServer Toolbox provides a web interface for configuring the BACpac card. Use the SMC FieldServer Toolbox to complete the following tasks:
1. Set configuration parameters for the BACnet connection, including the BACnet IP port number.
2. Apply the configuration CSV file generated using the ES Panel Programmer.

For documentation about use of the SMC FieldServer Toolbox, see Table 2.

Mass Changes Tool (MCT)

Use the Mass Changes Tool (MCT) to configure the Simplex integration into a Metasys SCT archive database. Use the MCT to complete the following tasks:
1. Define the network tree view and labels.
2. Define alarm extensions and priorities.
3. Define the *Metasys* UI equipment objects.

4. Transfer the equipment information to an SCT archive database, either by creating a *Metasys* import file or by connecting directly to SCT.

**Configuring the Simplex Integration in MCT**

1. Launch MCT.
2. From the **File** menu, click **New**.
3. In the **New File - Type** window, select **Simplex Fire Integration** and click **Next**.
4. In the **All Items** tab, select the options for **General**, **Devices**, and **Points** as shown in Figure 2.  
   ○ **Note:** In SCT, searches are performed using the **Name** of objects. In MCT, select the option to generate names that includes the information that you need to identify the devices and points.

   **Figure 2: All Items for Simplex Fire Integration**

5. Click the **Alarms** tab.
6. Configure the alarms options.
7. Click the **All Items** tab.
8. Click the browse button and navigate to the CSV file generated by the ES Panel Programmer.
9. Click **Open**.
10. Click **Generate**. MCT presents a preview of the objects. To change the generated names, adjust the selections for **General**, **Devices**, and **Points**, and click **Generate**.
11. Click the **Metasys UI** tab.

12. Optional: to configure the options for **Metasys UI**, complete the following steps:
   a. Select the **Include Metasys UI objects** check box.
   b. Select the **Equipment** check box.
   c. Click the device name, click **Edit**, and update the device name to match the device in the SCT archive.
   d. To rename the Equipment subfolder, click the subfolder, click **Edit**, then enter a new name.
   e. Select the **Equipment Definition** check box.
   f. To rename the Equipment Definition subfolder, click the subfolder, click **Edit**, and enter a new name.
   g. Select the strategy used to create Equipment Definitions (**Point Type** or **Groups**).
h. Review the Equipment Definitions and related pieces of Equipment.
   i. Enter a **Short Name** and a **Label** for the points in the Equipment Definitions.

   **Figure 4: Metasys UI Screen Showing Simplex FACU Integration**

13. Click **OK**.
The point information is generated and displayed. For information about additional properties that you can adjust in MCT, refer to the *User's Manual* and *Demo Video* available at [http://vsismi1srv.siselab.jci.com:81/mct/ea/](http://vsismi1srv.siselab.jci.com:81/mct/ea/)

**Importing the Integration into an SCT database**

1. In MCT, from the **File** menu, click **Save**. The file is saved with an `.imp` extension.
2. Launch SCT.
3. Open the SCT archive.
4. If the archive does not include a BACnet integration, see *Adding a BACnet IP Integration to*
complete the required steps.

5. Right-click the BACnet integration to open a submenu. Click **Import Integration**.

6. Select the `.imp` file. If there are multiple `.imp` files, import one at a time in numerical order of their file names.

**Inserting the Integration into an SCT database from MCT**

1. If the archive database does not include a BACnet integration, see **Adding a BACnet IP Integration** to complete the required steps with SCT.

2. In MCT, from the **File** menu, click **Insert into SCT Database**.

3. Enter a **User Name** and **Password** to connect to SCT installed on the same computer.

4. Click **Connect**

5. Select the Archive database and the BACnet Integration.
   - **Note:** If the archive database does not include a BACnet integration, open the archive in SCT and add a BACnet IP integration.

6. Click **OK**. The objects are created inside the selected integration and inside the ADS (UI objects).
System Configuration Tool (SCT)

Use SCT to complete the following tasks:
1. Add a BACNet/IP Integration.
2. Define the spaces for your site.
3. Add equipment to spaces.
4. Upload information to the supervisory device and Metasys server.

Adding a BACnet IP Integration

You can only load Simplex FACU point data into an archive that includes a BACnet/IP integration. To add a BACnet integration to an archive, complete the following steps:
1. From the Insert menu, click Integration.
2. In the Insert Integration Wizard, click BACnet IP.
3. Click Next.
4. In the Destination tree view, select a supervisory device.
5. Click Next.
6. Enter a unique identifier for the integration.
7. Click Next.
8. In the Configuration panel, set the Authorization Category to Fire. Set any other configuration settings as required.
9. Click Next.
10. Review the summary, and click Finish to add the integration.

Defining Spaces in SCT

For comprehensive information about defining spaces in SCT, refer to the Spaces Overview section in Metasys SCT Help (LIT-12011964). The information included below is a summary of information included in that document, and focuses specifically on the Simplex FACU integration.

Plan your configuration before you configure spaces and equipment with SCT. Consider the number and types of spaces, and the hierarchical relationship between them. For more information, refer to the Planning for Spaces Configuration section in Metasys SCT Help (LIT-12011964).

Note: To create floor plans using the Metasys UI Offline that display FACU Point Information, you only need to define building-level spaces and floor-level spaces.
To define spaces, complete the following steps:

1. In SCT, open the archive that includes the Simplex integration.
2. From the Facility menu, click Edit Spaces Tree.
3. In the Spaces Tree Editor, click Edit.
4. Select the Site Object in the tree.
5. Click the New Folder button to create a space object.
6. Click the plus sign next to the Site Object to expand the Site node.
7. Click the space object. The first space object added is a generic, parent-level space object.
8. Select the generic, parent-level space object to edit its attributes.
9. Continue adding spaces. For an example of a space object type hierarchy, see Figure 6. To add a nested space object under a space object, select the space object in the tree view and click the New Folder button.
10. After you complete adding space objects to the Spaces Tree, click Save.

Assigning Equipment to Spaces

For comprehensive information on defining spaces in SCT, refer to the Assigning Spaces Served By Equipment Relationships section in Metasys SCT Help (LIT-12011964). The information included below is a summary of information included in that document, and focuses specifically on the Simplex FACU integration.

Notes:

- Assign FACU Equipment to floor-level spaces to simplify the creation of floor plan graphics in the Metasys UI Offline.
- Equipment Definitions are included with the data imported into SCT from MCT.

To define how spaces are served by equipment, complete the following steps:

1. In SCT, open the archive that includes the Simplex integration.
2. From the View menu, click Panel Layout, then Two Panel Vertical.
3. In the Equipment Tree, select the lowest level folder that contains the equipment objects, then from the Query menu, click Global Search. The Global Search Viewer opens in the left panel.

4. From the Facility menu, click Edit Spaces Tree. The Spaces Tree Editor opens in the right panel.

Figure 7: Arranging the SCT interface to add equipment to spaces

5. In the Spaces Tree Editor, click Edit.

6. In the Spaces Tree Editor, select the space that you are adding equipment to.

7. In the Global Search Viewer, enter a search value in the Object Name text field for the equipment that you are adding. Use the wildcard character (*) to search for partial matches. For example, enter *1st* to search for the occurrence of 1st anywhere within an object name. This would include objects named 1st floor balcony, 1st floor room 107, and kitchen on the 1st floor.

8. Click Search.

9. In Search Results, select the equipment objects that you are adding to a space.

10. Drag the selected equipment objects from the Global Search Viewer to the Served By attribute value in the Spaces Tree Editor.
**Metasys® UI Offline**

Use Metasys UI Offline to complete the following tasks:

1. Configure the graphical representation of spaces.
2. Add symbols to floor plans to represent FACU point information.
3. Bind FACU point information to symbols.
4. Create a graphical representation of the FACU.

**Configuring the Graphical Representation of Spaces**

For comprehensive information on configuring the graphical representation of spaces in Metasys UI Offline, refer to the Metasys UI Graphics section in Metasys UI Offline Help (LIT-12012116). The information included below is a summary of information included in that document, and focuses specifically on the Simplex FACU integration.

To add a floor plan for a space, complete the following steps:

1. In Metasys UI Offline, click the user menu in the upper right corner, then click **Graphics Manager**.
2. In the **Equipment and Spaces** panel, select a space to add a floor plan to.
3. In the **Graphics List** panel, click the plus symbol.
4. In the **New Graphic** window, expand the **Blank** section of the tree view, then select the **Blank** template.
5. In the **Name** field, enter a name for the floor plan and click **Create**. The Graphics Editor
appears.

6. In the toolbar, click the Layers button.

7. In the Background layer, click **Change**.

8. In the **Image Gallery** window, click **Choose**, browse for a floor plan image, and click **Open**.

9. Click **Add**, and select the image file that is added to the **Image Gallery**. The selected image is displayed as the background.

10. Click **Save**.

![Figure 9: Floor Plan Added to Layer](image)

**Adding Symbols to Floor Plans**

For comprehensive information on using symbols in *Metasys UI Offline*, refer to the **Working with Symbols** section in *Metasys UI Offline Help (LIT-12012116)*. The information included below is a summary of information included in that document, and focuses specifically on the Simplex FACU integration.

Create a floor plan as described in **Configuring the Graphical Representation of Spaces**, then complete the following steps:

1. In the sidebar, click the Symbols button.

2. Click the **Fire** heading to expand that section.

3. Drag the required symbols from the **Symbols** panel onto the floor plan.

4. To reposition a symbol, click the symbol, then drag the symbol to a new location.

NAE Commissioning for Simplex Fire System Integration
Figure 10: Adding Symbols

Binding FACU Point Information to Symbols

For comprehensive information on bindings in Metasys UI Offline, refer to the Working with Bindings section in Metasys UI Offline Help (LIT-12012116). The information included below is a summary of information included in that document, and focuses specifically on the Simplex FACU integration.

Add symbols as described in Adding Symbols to Floor Plans, then complete the following steps:

1. Click a symbol.
2. From the Edit toolbar, click the Bindings button. The Bindings panel opens.
3. In the Explicit tab, browse to and select the point or location you would like to bind to. Drag the point or location into the appropriate bindings field in the Bindings list.
4. Repeat step 1 to step 3 for all symbols on the floor plan.
5. Click Save.
Creating a Graphical Representation of the FACU

The FACU is represented in the Metasys UI by an Equipment Definition object. For a description of the points included in the Equipment Object, see Table 3. Use an Aliased Graphic to create a graphical representation of the FACU. Figure 12 shows an example graphic.
Figure 12: Example Aliased Graphic for the Fire Panel Status Equipment Object

<table>
<thead>
<tr>
<th>Callout</th>
<th>Point Label</th>
<th>BACnet Point Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>UNACKNOWLEDGED FIRE ALARM EXISTS</td>
<td>BI</td>
</tr>
<tr>
<td>2</td>
<td>NUMBER OF SYSTEM FIRE ALARMS</td>
<td>AI</td>
</tr>
<tr>
<td>3</td>
<td>UNACKNOWLEDGED SUPERVISORY EXISTS</td>
<td>BI</td>
</tr>
<tr>
<td>4</td>
<td>NUMBER OF SYSTEM SUPERVISORIES</td>
<td>AI</td>
</tr>
<tr>
<td>5</td>
<td>UNACKNOWLEDGED TROUBLE EXISTS</td>
<td>BI</td>
</tr>
<tr>
<td>6</td>
<td>NUMBER OF SYSTEM TROUBLES</td>
<td>AI</td>
</tr>
<tr>
<td>7</td>
<td>EXCESSIVELY DIRTY (OUT OF RANGE)</td>
<td>AI</td>
</tr>
<tr>
<td>8</td>
<td>DIRTY SENSOR COUNTER</td>
<td>AI</td>
</tr>
<tr>
<td>9</td>
<td>ALMOST DIRTY COUNTER</td>
<td>AI</td>
</tr>
<tr>
<td>10</td>
<td>CARD MONITOR</td>
<td>BI</td>
</tr>
<tr>
<td>11</td>
<td>DEPLETED/MISSING BATTERY</td>
<td>BI</td>
</tr>
<tr>
<td>12</td>
<td>BATTERY LOW</td>
<td>BI</td>
</tr>
<tr>
<td>13</td>
<td>AC FAILURE</td>
<td>BI</td>
</tr>
<tr>
<td>14</td>
<td>NEGATIVE EARTH</td>
<td>BI</td>
</tr>
<tr>
<td>15</td>
<td>POSITIVE EARTH</td>
<td>BI</td>
</tr>
<tr>
<td>16</td>
<td>AC VOLTAGE FAILURE/BROWNOUT</td>
<td>BI</td>
</tr>
</tbody>
</table>
For comprehensive information on configuring Aliased Graphics for Equipment Definitions in Metasys UI Offline, refer to the Creating Aliased Graphics section in Metasys UI Offline Help (LIT-12012116). The information included below is a summary of information included in that document, and focuses specifically on the Simplex FACU integration.

To create an aliased graphic, complete the following steps:

1. In Metasys UI Offline, click the user menu in the upper right corner, then click Graphics Manager.

2. Click Equipment Definitions, then select the FIRE PANEL.

3. Click ADD ALIASED GRAPHIC.

4. In the New Graphic window, expand the Blank section of the tree view, and select the Blank template.

5. In the Name field, enter a name for the FACU graphic and click Create. The Graphics Editor appears.

6. Optional: To add a background image, complete step 6 to step 10 in Configuring the Graphical Representation of Spaces.

7. Optional: To add text labels to the FACU, in the sidebar click Drawing Tools and Shapes, and drag Text Tool graphics on to the FACU graphic.

**Configuring Symbols for the FACU Aliased Graphic**

1. To add Symbols, see Adding Symbols to Floor Plans, with the following exceptions:
a. Use symbols from the **Basic** section.

b. Use State Circle, State Square, or State Triangle graphics for Binary Inputs (BI).

c. Use the Basic Value Box graphic for Analog Inputs (AI).

2. To bind point information to the symbols, see Binding FACU Point Information to Symbols, but use points listed in the **Alias** tab.

   ☎ **Note:** AI values are prefixed with a # symbol.

3. To set an appropriate color for the BI states, complete the following steps:

   a. Click a symbol.

   b. Click the Property Panel button.

   c. Click a colored square, select a color, and click **OK**.

   **Figure 14: Selecting State Colors**

   ☎ **Note:** BI values for the FACU Equipment Definition have two states. State 0 is the normal state. State 1 indicates an abnormal condition; for example, a fire or technical failure.

4. Complete configuration of the Aliased Graphic, then click **Save**.

5. Click **Exit** to return to the **Graphics Manager**.
Downloading the Archive to Devices

The Manage Archive Wizard download option transfers a copy of the SCT archive database into the engine or ADS/ADX/ODS database. For comprehensive information about downloading to devices using SCT, refer to the Manage Archive section in Metasys SCT Help (LIT-12011964). The information included below is a summary of information included in that document, and focuses specifically on the Simplex FACU integration.

To download the archive, complete the following steps:
1. From the Tools menu, select Manage Archive. The Manage Archive wizard appears.
2. Select Download to Device.
3. Click Next.
4. Select the devices to download and click Next.
5. Select the download Schedule method and click Next.
6. Select the Site Login method.
7. Review the download Summary, then click Finish to perform the download.
8. After the download process is complete, verify the Completion Status column in the Completed Actions window reports OK.

Software Terms

Use of the software embedded in this product or access to the hosted services (including SaaS and PaaS) applicable to this product, if any, is subject to applicable terms set forth at www.johnsoncontrols.com/techterms Your use of this product constitutes an agreement to such terms. If you do not agree to be bound by such terms, you may return the unused product to your place of purchase.